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The Community Resilience Scenario Planning Model (CRSPM) consists of technology and tools designed for this
project. It utilizes ArcGIS® desktop software coupled with the extensions Arc Hydro and CommunityViz®. Arc Hydro
is a model and toolkit designed to delineate overland stormwater flows based on topographic data. CommunityViz
is a scenario planning decision support tool. The dynamic analysis engine allows for open formulaic programming,
making the software customizable for purposes such as the CRSPM. This combination of tools provides an effective
platform for visualizing stormwater accumulation and impacts, exploring contributing factors and testing potential
solutions to problems.
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Figure 1: CRSPM Tool Diagram

Arc Hydro Flow Path Model
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Figure 2: Flow Path Map
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Figure 3: Flow path map without sewer inlets (left), including existing and, where available, proposed sewer inlets (right).

For this project, Hey and Associates, Inc. prepared the Arc Hydro flow path model for the neighborhoods in the
Village of Downers Grove, lllinois, under study. In the three neighborhoods studied, two model runs were prepared.
The first includes just terrain data and structure footprints. The second adds sewer system inlets, including some
future infrastructure improvements where proposed and defined.

This CRSPM table of contents includes the flow path data layers (Arc Hydro outputs) and layers used as Arc Hydro

model inputs.
TABLE 1: ARCHYDRO MODEL DATA
Source Layer Name Geometry
Local Input Building Polygon
Local Input DEM Raster
Local Input Topography Polyline
ARc Hydro Qutput Flow Path No Sewer Raster
ARC Hydro Output Flow Path Sewer Raster

Other Geographic Information System Data Inputs

In addition to the flow path data, the CRSPM table of contents includes
several datasets. Locally provided data includes infrastructure (streets,
railroads, detention basins, water and sewer pipes and points), building
footprints, water data (FEMA Flood Insurance Rate Maps, floodways,
Localized Poor Drainage Areas', watersheds with sub basins),
impervious surfaces, parks, parcels, zoning and future land use. Most of
this data is included for reference only although some local data sets
are used in the dynamic analysis components.

"http://www.downers.us/res/stormwater-management/lpda-amp-flood-plain

Localized Poor Drainage Area (LDPA):

The village identified these locations as
prone to flooding due to topography.
Stormwater runoff tends to accumulate in
these areas creating risk of flooding

Planning.org/nationalcenters/hazards
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Reference data layers are for the user to be able to view and symbolize information which might aid in orienting
the user or provide pertinent content for decision making. They do not directly interact with the dynamic model
analysis components.

Table 2: Reference Data Layers

Source Layer Name Geometry
Local Active_LPDAs Polygon
Local Detention_Basin_Boundary Polygon
Local Detention_Basins Point
Local FloodWay Polygon
Local FP_100Year Polygon
Local FP_500Year Polygon
Local Future_Land_Use Polygon
Local Municipal Boundary Polygon
Local Non_Village_Storm_Pipes Polyline
Local Non_Village_Storm_Structures Point
Local Storm_Channel Polyline
Local Storm_Pipes Polyline
Local Storm_Pipes_ND Polyline
Local Storm_Points Point
Local Streets Polyline
Local Unincorporated_LDPAs Polygon
Local WaterSheds with SubBasins Polygon
Local Zoning Polygon
Pre-processed Clip_Study_Area Polygon
Pre-processed Study_Area_Boundary Polygon
Pre-processed Study_Area_Mask Polygon

There are some data layers included for reference that include dynamic calculations. These layers can be used to
provide visualization of some model information, such as impervious ratio or building coverage percent. They do
not affect the core model formulas for impervious runoff.

Table 1: Dynamic Reference Layers

Source Layer Name Geometry
Local Impervious_Surface_Polygons Polygon
Local Parcels Polygon
Pre-processed Grid_10x10 Polygon

Finally, the CRSPM includes the layers used for dynamic analysis. Data about impervious surface and stormwater
runoff are calculating directly from this data. The CRSPM manages these layers directly.

Planning.org/nationalcenters/hazards
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Table 2: Dynamic Analysis Layers

Source Layer Name Geometry
Analysis Auto-generated Summary_Selection Polygon
Preprocessed Landcover_Paint Polygon
User Defined Location Selection Polygon

Preprocessing Data for Analysis

Prior to building a CRSPM project, the data should be prepared for use in the model. Reference data, including
dynamic reference layers, can be considered optional for use in a project. If the user wants to include the data
listed in the current table of contents, input data should match the geometry type specified and data should be
clipped to a defined clip area. The clip area should be larger than the study area to provide context, but not so
large as to hinder model rendering and other performance considerations. All data should be projected to a
common geographic projection.

A 10" by 10" vector grid was built for the project study area. The user can choose to build a similar grid for their own
study area in GIS using the Fishnet? ArcToolbox tool or similar vector grid setup tool.

The primary preprocessed dataset for this project is the Landcover_Paint layer. This dataset is a polygon layer that
provides full coverage landcover information for the study area. For the Village of Downers Grove, the data was
derived from local data on impervious surfaces. Existing landcover types were established for each impervious type
and remaining land was assigned “turf” for ease of classification. This worked well in the urban residential context,
but could be refined for projects needing greater landcover diversity. The landcover data was also unioned with
the 10" by 10" grid layer to provide smaller units of measure for future landcover “paints.” Where impervious
polygons split grids, partial grids were created. This allowed for accurate land area for existing and proposed
change options.

Figure 4: Landcover data setup process.

Building a CSRPM Project

I Building
Deck/Patio
Driveway

I Parking

I Pavement/Roads
Pools

I Recreation Facilities

I Sheds

Sidewalks

Each neighborhood studied in the Village of Downers Grove pilot is setup as a uniqgue CommunityViz project. The
CRSPM can be templated to new locations within the village, in other parts of DuPage County, lllinois, or beyond.
The following explains the steps to apply the CRSPM Super Template.

2 http://pro.arcgis.com/en/pro-app/tool-reference/data-management/create-fishnet.htm
Planning.org/nationalcenters/hazards
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Step 1: Obtain and prepare desired data for use in the CRSPM analysis per the previous documentation.

Step 2: Create a new empty CommunityViz analysis.?

&
G
?

conimunity21z

Create New Analysis

Start Scenario 360 Help

& Welcome to Scenario 360 >< > This PC > Windows (C:) » CVFiles » DG_Hobson_Triangle
. - [ Name -
: 1 ’ Welcome to Scenario 360
- . ~Backup
* . Open Recent Analysis Why isn't my analysis in the list? 3D
~ ° Compare Images
e CVAnalysis.gdb
-~ T:\ > Data
. e L4 Reports
9 ® s Sticky Notes
- @] CVAnalysis.mxd
q0) 0 CVAnalysisinfo.xml
: 0 CVAnalysisLog.xml
d
O Open Existing Analysis
)

Figure 5 and 6: CommunityViz welcome screen (left); Example CommunityViz project folder structure.

This will create a project folder in the specified file location, the default being C:\CVFiles. The name of your analysis
will be the name of the folder stored in this location. Inside every CommunityViz project folder, there will be a
CVAnalysis.mxd, a CVAnalysis.gdb and a CVAnalysisinfo.xml. These files are automatically created by CommunityViz
and are necessary to the structure of the analysis. CommunityViz also creates several folders which may initially be
empty for potential future use in storing components of a CommunityViz project.

Step 3: Load Super Template “CRSPM_Template”. This option can be found on the Scenario 360 drop-down >
Analysis > Load Template. ... Once in the load browser window, navigate to the location where the

— -

CRSPM_Template.cvtem file is stored. The
default recommended storage location is
C\CVFiles\Templates. Make sure the file type
drop-down is set to Super Templates (*.cvtem).
Select “CRSPM_Template.cvtem” and click

Figure 6: Scenario 360 drop-down menu > Analysis > Load

Scenario 360 v |<[di o | Y -
T Start L}
| Analysis b 3 New..
Data » [ Open..
View 4 Save Analysis As... - Open.
Presentation » | Load Template... l
Reports > Save ——
Alerts N m — Load Scenario Template
Tools » B Analy Load a previously saved template
Sketch di= Sticky Notes
Default Settings... I
2 Help :
Improve Analysis Performance...
About i Template..

3The user must install ArcGIS 10.3 or newer and CommunityViz 5.1 or newer software.
Planning.org/nationalcenters/hazards
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Step 4: In Windows Explorer, copy the editing toolbox “DG_Toolbox” into the analysis data folder.

Step 5: With the project open in CommunityViz, load data for your study area.

S _
Scenario 360 v | i | Y -
T Start L
Analysis »
Data » | ¥’ Start Scenario Editing
View > (D) -
Presentation * |E8 Dynamic Updates...
Reports * | B8 Update Analysis
Alerts * | M Update IsSelected Formulas
e ’ External Table Links...
Sketch »
) Load Data...
Default Settings... =,
? Help Load Local Data
About Load local data to layers in this
il . analysis

Figure 7: Scenario 360 drop-down > Data > Load Data...

Reference Data: The user can choose to bring in data for any of the reference layers in the table of contents using
the CommunityViz Load Data ... feature. This pulls data into the preexisting layers for your local study area
seamlessly. Data which is not currently included in the CRSPM table of contents can also be added, just as with any

ArcMap map document, using the ArcMap add data ® button.

Dynamic Reference Data: Dynamic Reference Layers should be populated using the CommunityViz Load Data ...
option. If the user chooses not to use these reference layers, they should remain in the project file as empty data
layers.

Dynamic Analysis Data: The only dynamic layer that needs to be populated is the Landcover_Paint layer. This
layer should be prepared in a similar manner to the described preprocessing steps. Any polygon layer with a field
"Type” will be accepted as a load data option, but user paint unit, such as the 10" x 10" grid, should be a
consideration. In other words, large landcover polygons should be broken out into smaller more manageable

polygons.

Using the CRSPM

The CRSPM is designed to be a ready-to-use scenario testing tool. Existing CRSPM projects, such as the
neighborhoods built for the pilot, can be used directly by planners, practitioners, local officials, and residents alike.
It is best for someone skilled in basic GIS to operate the model as it sits directly in ArcMap desktop, but the user
need not be an expert in GIS.

To run a CRSPM project, use the following steps.

Planning.org/nationalcenters/hazards
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Step 1: Open the CRSPM project file. The default project storage for CommunityViz projects is C\CVFiles.

Step 2: Review data in the study area and explore the flow path information. Determine which properties the user
would like to explore with “what-if” scenarios for changing runoff potential. Zoom and pan as needed to provide a
good view of the property(ies) of interest.

™
Step 3: Start Editing |/ . The Location Selection and Summary_Selection layers should be turned on in the Table
of Contents by default, but confirm that they are accessible in the Create Features window layer list.

Step 4: In the Create Features window, click on the Runoff Summary option under “Location Selection.” This will
automatically bring up the Polygon Construction Tool. On the map, draw a polygon for the area of interest. Any
portion of the Landcover_Paint layer data is available to select using this Runoff Summary boundary.

Figure 8: Sketch boundary for the runoff summary
location selection.

Green Roof Deck
[WlPevementRosds
[CJporous Pavement
' A Sdewaks
Scenario 360 - Dynamic Update Swale/Ran Garden [ Turf
Woods/Trees

Updating Run Runcff Model (Base Scenario)

[E Construction Tools

Step 5: In the Create Features Window, choose a Summary_Selection landcover type you want to paint over an
existing landcover type within the area of interest. For example, click on Porous Pavement in the list and then on
the map click on a driveway feature. If you drag the paint cursor over multiple features while holding the left

- o ; mouse button down, you can paint over a larger

lick here to see templates not listed.

Comment its

e area.

P Figure 10: Paint future landcover options.
Parcels

S::::\,Se\emon

Ml suidng DedkPatio
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W Parking [llPavementRoads
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"
[ Construction Tools
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Step 6: Review the results in the charts. There are four main charts | @ ‘ b
provided in the CRSPM. You can review estimated stormwater runoff Existing Landcover Percent
" %0
for the existing landcover and the user proposed changes. There is -
. . . Runoff by Landcover
also a net change to quickly see the positive or negative change from A
existing to future. The user can see runoff by landcover type to e
. . : . Runoff Net Change
explore which landcover types provide the largest contributions to tastaca e
€D Chart Selected Area... — =
runoff. The existing landcover percent shows the [ R Selected Area Runoft
. . . . . CdDeck "
impervious:pervious surface ratio for the selection area. Do, 0] ey B
P = g 12000
. . . . . 10.000
Step 7: Review and change input assumptions as desired. The . - 3 oo
CRSPM includes multiple assumptions behind the runoff calculations. B e
The main assumption is the amount of rainfall. You can quickly 200
. . 0
change the default rain event from one inch to a larger or smaller Existing  Future

- ——

rainfall amount.
Figure 9: Charts in the CRSPM.
The model also includes more expert driven assumptions for the

runoff calculations. These include landcover-based coefficients for
runoff absorption. These assumptions can be viewed by the user, but are locked to their assigned value. Any
changes to these assumptions would need to be done in the assumption setup by an expert.

Assumptions o x
Graphical Tabular
Scenario  Active (Base Scenario) v @ ) | c« o > 2 €2
i 85th Storm 5
Rainfall Amount W < - ' > 1.00 inches

Figure 10: Rainfall amount assumption slider bar.

Assumptions 0O x
Graphical Tabular

Name Units Base Scenario
Impervious Standard 98
Tuf CN 74
Woods CN 74
Green Roof CN 75
Porous Pavement CN 40
Swale or Rain Garde... 63

Figure 113: Runoff coefficient assumptions.
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Step 8: Save changes as desired. Click to Stop Editing. You can choose to save edits if you want to keep your
work for future reference. If you discard edits, you can return to this project as a blank canvas and work on other
locations or different iterations. If you save your work, you can always delete the area of interest by selecting the
runoff summary feature (pink boundary) and deleting that. This will delete the landcover data in the
Summary_Selection. You can then draw a new area of interest following the instructions in step 4.

Links to Training Resources

CommunityViz, ArcGIS and Arc Hydro are all software tools with a broad spectrum of training materials. This
document does not attempt to provide technical or training documentation on the core software used. Here are a
few resources for users interested in exploring or training more on the suite of tools used in the CRSPM.

For more information on CommunityViz software, explore the CommunityViz homepage: http://communityviz.city-
explained.com/index.html.

Training resources for CommunityViz can be obtained from the CommunityViz Resources section under tutorials.
The second link will take you directly to video tutorials.

http://communityviz.city-explained.com/communityviz/resources.html|

http://communityviz.city-explained.com/communityviz/videotutorials.ntml

For more information on ArcGIS software and training go to the ESRI website:

https://www.esri.com/en-us/home

For information on Arc Hydro, you can search online as this may change over time. The current help topic on this is
found at the following link.

http://resources.arcgis.com/en/communities/hydro/01vn0000000s000000.htm

Conclusion

The CRSPM toolkit combines a clear way to visualize overland flow at a local property level with interactive design
components to test potential landcover changes. This toolkit can be templated to a user chosen location and the
analysis replicated for immediate use. The data, impacts, and sketch tools are designed to be applicable for
workshops with a public audience, working with stakeholder groups, and planning staff initial review and testing of
design alternatives.

Planning.org/nationalcenters/hazards
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